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 Important Information

Warranty
The NI ELVIS II hardware is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as 
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective 
during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in 
materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments 
will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects 
during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any 
equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by 
warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In 
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document 
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National 
Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING 
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of 
the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against 
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service 
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the 
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside 
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other 
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only 
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your media, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE 
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, 
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR 
ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF 
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY 
UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, 
THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, 
INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS 
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION 
DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY 
RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER 
NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT 
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Conventions

The following conventions are used in this manual:

<> Angle brackets that contain numbers separated by an ellipsis represent a 
range of values associated with a bit or signal name—for example, 
AO <3..0>.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this icon is marked on the 
product, refer to the Read Me First: Safety and Radio-Frequency 
Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product, it denotes a warning advising you to 
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be 
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.
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1
About NI ELVIS II

This document contains information about the National Instruments 
Educational Laboratory Virtual Instrumentation Suite II (NI ELVIS II) 
architecture and instruments.

This chapter provides an overview of the NI ELVIS II and its possible uses 
in various academic disciplines.

Note Refer to the Where to Start with NI ELVIS II document for information about how 
to set up the NI ELVIS II.

What You Need to Get Started
Refer to Where to Start with NI ELVIS II for a list of hardware, software, 
documentation, and tools you need to set up and use the NI ELVIS II.

NI ELVIS II Overview
NI ELVIS II uses LabVIEW-based software instruments and a 
custom-designed benchtop workstation and prototyping board to provide 
the functionality of a suite of common laboratory instruments.

NI ELVISmx is the software that supports NI ELVIS II hardware. It 
provides the following LabVIEW soft front panels (SFPs):

• Arbitrary Waveform Generator (ARB)

• Bode Analyzer

• Digital Reader

• Digital Writer

• Digital Multimeter (DMM)

• Dynamic Signal Analyzer (DSA)

• Function Generator (FGEN)

• Impedance Analyzer

• Oscilloscope (Scope)
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• Two-Wire Current Voltage Analyzer

• Three-Wire Current Voltage Analyzer

• Variable Power Supplies

Also included are LabVIEW Express VIs and SignalExpress steps to 
program NI ELVIS II in these environments as well as NI ELVIS 
instruments integrated into NI Multisim.

Refer to Figure 2-1, Typical NI ELVIS II System, for an illustration of 
NI ELVIS II.

NI ELVIS II in Academic Disciplines
You can use NI ELVIS II in engineering, physical sciences, and biological 
sciences laboratories. Instructors can implement the NI ELVIS II 
curriculum with beginning to advanced classes to provide hands-on 
experience to students.

NI ELVIS II in Engineering
NI ELVIS II is suited for teaching basic electronics and circuit design to 
students in electrical engineering, mechanical engineering, and biomedical 
engineering. The suite offers full testing, measurement, and datalogging 
capabilities needed for such training. Students can use the removable 
NI ELVIS II Series Prototyping Board (prototyping board) at home to build 
circuits, thus using laboratory time more effectively.

NI ELVIS II SFP instruments, such as the Bode Analyzer and Dynamic 
Signal Analyzer, offer instructors an opportunity to teach advanced courses 
in signal analysis and processing. For example, students can construct 
software filters in LabVIEW and hardware filters on the prototyping board 
and compare the performance.

Mechanical engineering students can learn sensor and transducer 
measurements, in addition to basic circuit design by building custom 
signal conditioning. Students can install custom sensor adapters on the 
prototyping board. For example, installing a thermocouple jack on 
the prototyping board allows robust thermocouple connections. The 
programmable power supply can provide excitation for strain gauges used 
in strain measurements.
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NI ELVIS II in Biological Sciences

Caution The NI ELVIS II hardware is not environmentally sealed; therefore, exercise 
caution when using NI ELVIS II in chemical and biological applications.

Biomedical engineering departments have challenges that are similar to 
those of mechanical departments. Students typically learn basic electronics 
and build instruments such as those used to measure temperature. 
The prototyping board offers signal conditioning capability for temperature 
sensors, and the NI ELVISmx SFP instruments are ideal for testing the 
circuits as students build the signal conditioning circuits.

NI ELVIS II in Physical Sciences
Physics students typically learn electronics and circuit design theory. 
NI ELVIS II provides these students with the opportunity to implement 
these concepts. For example, physics students can use NI ELVIS II to build 
signal conditioning circuits for common sensors such as photoelectric 
multipliers or light detector sensors.

Related Documentation
The following documents contain information that you might find helpful 
as you read this manual:

• Where to Start with NI ELVIS II, available in PDF format on the 
NI ELVIS II Software CD.

• NI ELVISmx Help, available on the NI ELVISmx Software CD.

• NI ELVIS II Specifications, available at zone.ni.com/manuals.

• NI ELVIS II Theory of Operations, available at zone.ni.com.

• Getting Started with LabVIEW, available by selecting National 
Instruments»LabVIEW x.x»LabVIEW Manuals.

• LabVIEW Help, available by selecting Help»VI, Function, and 
How-To Help from the LabVIEW block diagram or front panel.

• LabVIEW Fundamentals, available by selecting National 
Instruments»LabVIEW x.x»LabVIEW Manuals.

• Measurement & Automation Explorer Help for DAQmx, available by 
selecting Help»Help Topics»NI-DAQmx from the Measurement & 
Automation Explorer (MAX) window.

• Getting Started with SignalExpress, available by selecting National 
Instruments»LabVIEW SignalExpress.
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• NI Express Workbench Help, available by selecting Help»Express 
Workbench Help from the SignalExpress window.

• Using NI ELVISmx Instruments in NI Multisim, available in the 
NI Multisim Help.

• ni.com/academic for various academic resources.

NI documentation is also available at ni.com.
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2
NI ELVIS II Hardware

NI ELVIS II combines hardware and software into one complete 
laboratory suite. This chapter provides an overview of the NI ELVIS II 
Benchtop Workstation.

Figure 2-1 shows a typical diagram of an NI ELVIS II system.

Figure 2-1.  Typical NI ELVIS II System

1 Laptop Computer
2 USB Cable
3 NI ELVIS II Benchtop Workstation

4 Prototyping Board
5 AC/DC Power Supply (Included with NI ELVIS II)
6 To Power Outlet

1

52

3

6

NI ELVIS II

 NATIONAL 

INSTRUMENTS

4
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NI ELVIS II Benchtop Workstation

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document 
before removing equipment covers, or connecting or disconnecting any signal wires.

This section describes the NI ELVIS II Benchtop Workstation.

The workstation control panel provides easy-to-operate knobs for the 
variable power supplies and function generator, and offers convenient 
connectivity and functionality in the form of BNC and banana-style 
connectors to the function generator, scope, and DMM instruments.

Figure 2-2 shows the control panel parts locator diagram.

Figure 2-2.  Top View of NI ELVIS II Benchtop Workstation with Prototyping Board

1 NI ELVIS II Series Prototyping Board
2 DMM Fuse
3 DMM Connectors
4 Oscilloscope Connectors
5 Function Generator Output/Digital Trigger Input 

Connector

6 Prototyping Board Mounting Screw Holes
7 Prototyping Board Connector
8 Prototyping Board Power Switch
9 Status LEDs
10 Variable Power Supplies Manual Controls
11 Function Generator Manual Controls
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The benchtop workstation has the following controls and indicators:

• USB LEDs

– Ready—Indicates that the NI ELVIS II hardware is properly 
configured and ready to communicate with the host computer.

– Active— Indicates activity on the USB connection to the host 
computer.

• Prototyping Board Power Switch and LED—Controls the power to 
the prototyping board.

Caution Ensure that the prototyping board power switch is off before inserting or 
removing it from the benchtop workstation.

• Variable Power Supplies Controls

– Positive Voltage Adjust Knob—Controls the output voltage of 
the positive variable power supply. The positive supply can output 
between 0 and +12 V.

– Negative Voltage Adjust Knob—Controls the output voltage of 
the negative variable power supply. The negative supply can 
output between 0 and –12 V.

Note These knobs are only active when the associated variable power supply is set to 
Manual Mode. An LED next to each knob lights when the variable power supply is in 
Manual Mode.

Table 2-1.  Benchtop Workstation USB LED Patterns

ACTIVE LED READY LED Description

Off  Main power is off.

Yellow Off No connection to the host computer is detected. Make 
sure NI-DAQmx driver software is loaded and the 
USB cable is connected.

Off Green  Connected to a full speed USB host.

Off Yellow  Connected to a high speed USB host.

Green Green or Yellow  Communicating with host.
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• Function Generator Controls

– Frequency Knob—Adjusts the output frequency of the generated 
waveform.

– Amplitude Knob—Adjusts the amplitude of the generated 
waveform.

Note These knobs are only active when the Function Generator is set to Manual Mode. 
An LED next to each knob lights when the Function Generator is in Manual Mode.

• DMM Connectors

– Voltage, Resistance, and Diode Banana Jack (red)—The 
positive input for voltage based DMM functionality.

– Common Banana Jack (black)—The common reference 
connection for DMM voltage, current, resistance, and diode 
measurements.

– Current Banana Jack (red)—The positive input for DMM 
current measurements.

– Fuse Cartridge—Replaceable fuse to protect the current signal 
path. Refer to the NI ELVIS II Specifications at ni.com/manuals 
for fuse information

Note The NI ELVIS II DMM connections for voltage, current, resistance, and diode 
measurements are available only through the banana jacks. They are not routed to the 
prototyping board.

• Oscilloscope (Scope) Connectors

– CH 0 BNC Connector—The input for channel 0 of the 
oscilloscope.

– CH 1 BNC Connector—The input for channel 1 of the 
oscilloscope.

Note The NI ELVIS II Oscilloscope channels 0 and 1 are available only through the BNC 
connectors. They are not routed to the prototyping board.

• FGEN/Trigger Connector—Optional output of the function 
generator or a digital trigger input.
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NI ELVIS II Rear Panel
The NI ELVIS II rear panel has the following components, as shown in 
Figure 2-3:

• The benchtop workstation power switch. Use this switch to power on 
or power off the NI ELVIS II.

• An AC/DC power supply connection. Use this connector to provide 
power to the workstation.

• A USB port. Use this to connect the workstation to a computer.

• A Kensington security cable tie slot. Use this connector to secure the 
workstation.

• A laptop security cable lock connector. Use this connector to secure 
the workstation.

Figure 2-3.  Rear View of NI ELVIS II System

1 Prototyping Board Power Switch
2 Benchtop Workstation Power Switch
3 AC/DC Power Supply Connector

4 USB Port
5 Cable Tie Slot
6 Kensington Security Slot

NI ELVIS II

 NATIONAL 
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2

3

4
5

6

1
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NI ELVIS II Bottom Panel
The NI ELVIS II benchtop workstation bottom panel has two hinged legs 
to elevate the rear of the workstation, as shown in Figure 2-4.

Figure 2-4.  Bottom View of NI ELVIS II Benchtop Workstation

You can mount the benchtop workstation on a panel if required for your 
application. Figure 2-4 shows the mounting hole dimensions for panel 
mounting the benchtop workstation.

NI ELVIS II Circuit Protection
NI ELVIS II uses solid-state circuit protection on all I/O lines. The only 
user-servicable fuse protects the DMM and is accessible through the 
removable cartridge shown in Figure 2-2.

1 Hinged Rear Elevation Legs 2 Key Slot Vertical Mounting Holes

1

2
7.500 in.

(190.5 mm)

9.500 in.
(241.3 mm)
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NI ELVIS II Series Prototyping Board
This section describes the NI ELVIS II Series Prototyping Board and how 
to use it to connect circuits to NI ELVIS II.

The NI ELVIS II Series Prototyping Board connects to the benchtop 
workstation. The prototyping board provides an area for building electronic 
circuitry and has the necessary connections to access signals for common 
applications. You can use multiple prototyping boards interchangeably 
with the NI ELVIS II Benchtop Workstation.

Caution Ensure that the prototyping board power switch is off before inserting or 
removing it from the benchtop workstation.

You can use the prototyping board connector to install custom prototype 
boards you develop. This connector is mechanically the same as a standard 
PCI connector.

The prototyping board exposes all the signal terminals of the NI ELVIS II 
for use through the distribution strips on either side of the breadboard area. 
Each signal has a row, and the rows are grouped by function.
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Figure 2-5 shows the parts locator diagram for the prototyping board.

Figure 2-5.  NI ELVIS II Series Prototyping Board

Prototyping Board Power
The prototyping board provides access to ±15 V and a +5 V power 
supplies. You can use these voltage rails to construct many common 
circuits. Refer to the NI ELVIS II Specifications at ni.com/manuals, for 
more information about these voltage rails. If any of the power indicators 
are not lit when the prototyping board power is enabled, check the 
connected devices for a short circuit. Turn the prototyping board power 
switch off and back on to reset the current limiters.

1 AI and PFI Signal Rows
2 Benchtop Workstation Interface Connector
3 DIO Signal Rows
4 User Configurable LEDs
5 User Configurable D-SUB Connector
6 Counter/Timer, User-Configurable I/O,

and DC Power Supply Signal Rows

7 DMM, AO, Function Generator,
User-Configurable I/O, Variable Power Supplies,
and DC Power Supplies Signal Rows

8 DC Power Supply Indicators
9  User-Configurable Screw Terminals
10 User Configurable BNC Connectors
11 User Configurable Banana Jack Connectors
12  Screw Positions for Locking 
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Signal Descriptions
Table 2-2 describes the signals on the prototyping board. The signals are 
grouped by the functionality section where they are located.

Table 2-2.  Signal Descriptions

Signal Name Type Description

AI <0..7> ± Analog Inputs Analog Input Channels 0 through 7 ±—Positive and negative input 
channels lines to differential AI channels.

AI SENSE Analog Inputs Analog Input Sense—Reference for the analog channels in 
nonreferenced single-ended (NRSE) mode. For more information 
about AI modes, search for NI ELVIS II Theory of Operation at 
zone.ni.com.

AI GND Analog Inputs Analog Input Ground—Ground reference for the Analog Input 
signals.

PFI <0..2>, <5..7>, 
<10..11>

Programmable Functions 
Interface

PFI Lines—Used for static DIO or for routing timing signals.

BASE 3-Wire Voltage/Current 
Analyzer

Base excitation for bipolar junction transistors.

DUT+ DMM, Impedance, 2- and 
3-Wire Analyzers

Excitation terminal for Capacitance and Inductance measurements 
(DMM), Impedance Analyzer, 2-Wire Analyzer, and 3-Wire 
Analyzer.

DUT– DMM, Impedance, 2- and 
3-Wire Analyzers

Virtual ground and current measurement for capacitance and 
inductance measurements (DMM), the Impedance Analyzer, 
2-Wire Analyzer, and 3-Wire Analyzer.

AO <0..1> Analog Outputs Analog Output Channels 0 and 1—Used for the Arbitrary 
Waveform Generator.

FGEN Function Generator Function Generator Output.

SYNC Function Generator TTL output synchronized to the FGEN signal.

AM Function Generator Amplitude Modulation Input—Analog input used to modulate the 
amplitude of the FGEN signal.

FM Function Generator Frequency Modulation Input—Analog input used to modulate the 
frequency of the FGEN signal.

BANANA <A..D> User Configurable I/O Banana Jacks A through D—Connects to the banana jacks.

BNC <1..2>± User Configurable I/O BNC Connectors 1 and 2 ±—Positive lines tie to the center pins of 
the BNC connectors; negative lines tie to the shells of the BNC 
connectors.

SCREW 
TERMINAL 
<1..2>

User Configurable I/O Connects to the screw terminals.
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Connecting Signals

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document 
before removing equipment covers, or connecting or disconnecting any signal wires.

SUPPLY+ Variable Power Supplies Positive Variable Power Supply—Output of 0 to 12 V.

GROUND  Power Supplies Ground.

SUPPLY– Variable Power Supplies Negative Variable Power Supply—Output of –12 to 0 V.

+15 V DC Power Supplies +15 V Fixed Power Supply.

–15 V DC Power Supplies –15 V Fixed Power Supply.

GROUND DC Power Supplies Ground.

+5V DC Power Supplies +5V Fixed Power Supply.

DIO <0..23> Digital Input/Output Digital Lines 0 through 23—These channels are general purpose 
DIO lines that are used to read or write data.

PFI8 / 
CTR0_SOURCE

Programmable Function 
Interface

Static Digital I/O, line P2.0
PFI8, Default function: Counter 0 Source

PFI9 / 
CTR0_GATE

Programmable Function 
Interface

Static Digital I/O, line P2.1
PFI9, Default function: Counter 0 Gate

PFI12 / 
CTR0_OUT

Programmable Function 
Interface

Static Digital I/O, line P2.4
PFI12, Default function: Counter 0 Out

PFI3 / 
CTR1_SOURCE

Programmable Function 
Interface

Static Digital I/O, line P1.3
PFI3, Default function: Counter 1 Source

PFI4 / 
CTR1_GATE

Programmable Function 
Interface

Static Digital I/O, line P1.4
PFI4, Default function: Counter 1 Gate

PFI13 / 
CTR1_OUT

Programmable Function 
Interface

Static Digital I/O, line P2.5
PFI13, Default function: Counter 1 Out

PFI14 / 
FREQ_OUT

Programmable Function 
Interface

Static Digital I/O, line P2.6
PFI14, Default function: Frequency Output

LED <0..7> User-Configurable I/O LEDs 0 through 7—Apply 5 V for 10 mA device.

DSUB SHIELD User-Configurable I/O Connection to D-SUB shield.

DSUB PIN <1..9> User-Configurable I/O Connections to D-SUB pins.

+5 V DC Power Supply +5V Fixed Power Supply.

GROUND DC Power Supply Ground.

Table 2-2.  Signal Descriptions (Continued)

Signal Name Type Description
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Analog Input
The NI ELVIS II Series Prototyping Board has eight differential AI 
channels available—ACH<0..7>. You can configure these inputs in 
referenced single-ended (RSE) or non-referenced single-ended (NRSE) 
modes. In RSE mode, each signal is referenced to AIGND. In NRSE mode, 
each signal is referenced to the floating AISENSE line. Table 2-3 shows the 
channel mapping for each mode.

Table 2-3.  Analog Input Signal Mapping

NI ELVIS II Series 
Prototyping Board 

Terminals
Differential Mode 

(Default) RSE/NRSE Modes

AI0+ AI 0+ AI 0

AI0– AI 0– AI 8

AI1+ AI 1+ AI 1

AI1– AI 1– AI 9

AI2+ AI 2+ AI 2

AI2– AI 2– AI 10

AI3+ AI 3+ AI 3

AI3– AI 3– AI 11

AI4+ AI 4+ AI 4

AI4– AI 4– AI 12

AI5+ AI 5+ AI 5

AI5– AI 5– AI 13

AI6+ AI 6+ AI 6

AI6– AI 6– AI 14

AI7+ AI 7+ AI 7

AI7– AI 7– AI 15

AISENSE — AI SENSE

AIGND AI GND AI GND
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Grounding Considerations
The analog input channels are differential, you must therefore establish a 
ground point somewhere in the signal path. As long as the signal you are 
measuring is referenced to one of the AI GND pins, the measurement is 
correctly referenced. If you are measuring a floating source, such as a 
battery, connect one end of the signal to the ground.

Resource Conflicts
The AI timing engine is shared by several instruments within the 
NI ELVIS II. This means that these instruments cannot be used at the same 
time. Search for NI ELVIS II Theory of Operation at zone.ni.com for 
more details.

DMM

Voltage, Current, Resistance, Diode, and Continuity
The primary DMM instrument on NI ELVIS II is isolated and its terminals 
are the three banana jacks on the side of the benchtop workstation. For DC 
Voltage, AC Voltage, Resistance, Diode, and Continuity Test modes, use 
the VΩ  and COM connectors. For DC Current and AC Current modes, 
use the A and COM connectors. For easy access to circuits on the 
prototyping board, you can use banana-to-banana cables to wrap the signals 
from the user-configurable banana jacks to the DMM connectors on the 
benchtop workstation.
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Figure 2-6 shows the banana jacks on the benchtop workstation used for 
V/R/Diode/Continuity and for Current.

Figure 2-6.  Connections for DMM Measurements

1 Connectors for Voltage/Resistance/Diode/Continuity
2 Connectors for Current
3 Connectors for Capacitance/Inductance

 NATIONAL 
INSTRUMENTS

3

2

1

FUSE
F 3.15A H 250V

Sand Filled
5-20 mm

COM

A

60VDC
20Vrms

MAX

2A MAX

DMM

10V MAX

5V TTL

1M 25pF

SCOPE
10VDC

7Vrms MAX

V

CH 1

CH 0
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Capacitance and Inductance
The capacitance and inductance measurements of the DMM use the 
nonisolated Impedance Analyzer terminals, DUT+ and DUT–, on the 
prototyping board. Refer to Figure 2-6.

Oscilloscope
The two oscilloscope channels are available at BNC connectors on the side 
of the benchtop workstation. These channels have 1 MΩ input impedance 
and can be used with 1X / 10X attenuated probes. You can also use 
high-impedance Analog Input channels <AI 0..7> available on the 
prototyping board.

Analog Output
NI ELVIS II provides access to the two analog outputs at the AO0 and 
AO1 terminals. These channels are used for arbitrary waveform 
generation. AO0 is also used internally for BASE excitation in the 3-Wire 
Voltage/Current Analyzer. Search for NI ELVIS II Theory of Operation at 
zone.ni.com for more details.

Function Generator (FGEN)
The function generator output can be routed to either the FGEN/TRIG 
BNC connector or the FGEN terminal on the prototyping board. A +5 V 
digital signal is available at the SYNC terminal. The AM and FM terminals 
provide analog inputs for the amplitude and frequency modulation of the 
function generator output.

Power Supplies
The DC power supplies provide fixed output of +15 V, –15 V, and +5 V.

The variable power supplies provide adjustable output voltages from 
0 to +12 V on the SUPPLY+ terminal, and 0 to –12 V on the SUPPLY– 
terminal.

All power supplies on NI ELVIS II are referenced to GROUND.

Digital I/O
The digital lines exposed on the prototyping board are internally connected 
to port 0 of the device. You can configure them as input or output.
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Programmable Function Interface (PFI)
The PFI lines are TTL-compatible I/O that can route timing signals to and 
from the AI, AO, or counter/timer engines. They can also be configured as 
static digital I/O.

User-Configurable I/O
The prototyping board provides several user-configurable connectors: four 
banana jacks, two BNC connectors, and a D-SUB connector. Each pin of 
the connector has a connection to the distribution strips.

Eight bicolor (green/yellow) LEDs are provided for general digital output 
on the prototyping board. The green anode of each LED is connected to the 
distribution strip through a 220 Ω resistor, and each cathode is connected 
to ground. Drive the line with +5 V to turn the LED green or –5 V to turn 
the LED yellow,

Bode Analyzer
The Bode Analyzer uses the Function Generator to output a stimulus and 
then uses analog input channels AI 0 and AI 1 to measure the response and 
stimulus respectively.

Two-Wire Current-Voltage Analyzer
Connect the signal to DUT+ and DUT– when using the Two-Wire 
Current-Voltage Analyzer.

Three-Wire Current-Voltage Analyzer
The Three-Wire Current-Voltage Analyzer uses DUT+, DUT–, and BASE 
to plot the current-voltage response of a NPN or PNP bipolar transistor. 
Table 2-4 shows the transistor to prototyping board connections.

Table 2-4.  Transistor to Prototyping Board Connections

 Transistor Node Prototyping Board Connections

Base BASE

Collector DUT+

Emitter DUT–
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Counter/Timer
The prototyping board provides access to the two counter/timers on the 
device, which are also accessible from software. These inputs are used for 
counting TTL signals, edge detection, and pulse generation applications. 
The CTR0_SOURCE, CTR0_GATE, CTR0_OUT, CTR1_GATE, and 
CTR1_OUT signals are connected to the default Counter 0 and Counter 1 
PFI lines. Refer to the M Series User Manual for more information.
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3
NI ELVISmx Software

This chapter provides an overview of the NI ELVISmx software available 
for use with the NI ELVIS II.

The NI ELVISmx software, created in LabVIEW, takes advantage of 
the capabilities of virtual instrumentation. The software includes SFP 
instruments, LabVIEW Express VIs, and SignalExpress blocks for 
programming the NI ELVIS II hardware.

Using NI ELVIS II with SFP Instruments
NI ELVISmx provides SFP instruments, created in LabVIEW, and the 
source code for the instruments. You cannot directly modify the executable 
files, but you can modify or enhance the functionality of these instruments 
by modifying the LabVIEW code. The instruments are virtual instruments 
(VIs) that are necessary in typical laboratory applications.

Note For a detailed explanation of the SFP instruments and instructions for taking a 
measurement with each instrument, refer to the NI ELVISmx Help.

NI ELVISmx Instrument Launcher
The NI ELVIS Instrument Launcher provides access to the NI ELVISmx 
SFP instruments. Launch the Instrument Launcher by navigating to 
Start»All Program Files»National Instruments»NI ELVISmx»
NI ELVISmx Instrument Launcher. This opens the suite of LabVIEW 
SFP instruments.

To launch an instrument, click the button corresponding to the desired 
instrument. Select the NI ELVIS II device from the Device control.

Some instruments perform similar operations using the same resources of 
the NI ELVIS II hardware and therefore cannot run at the same time. If you 
launch two instruments with overlapping functionality that cannot run 
at the same time, the NI ELVISmx software generates an error dialog 
describing the conflict. The instrument with the error is disabled and will 
not function until the conflict is resolved. Search for NI ELVIS II Theory of 
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Operation at zone.ni.com for information about possible resource 
conflicts.

Arbitrary Waveform Generator (ARB)
This advanced-level SFP instrument uses the AO capabilities of the device. 
You can create a variety of signal types using the Waveform Editor 
software, which is included with the NI ELVISmx software. You can load 
waveforms created with the NI Waveform Editor into the ARB SFP to 
generate stored waveforms. Refer to the NI ELVISmx Help for more 
information about the Waveform Editor.

Since the device has two AO channels, two waveforms may be 
simultaneously generated. You can choose to run continuously or run once.

Bode Analyzer
By combining the frequency sweep feature of the function generator and 
the AI capability of the device, a full-function Bode Analyzer is available 
with NI ELVISmx. You can set the frequency range of the instrument and 
choose between linear and logarithmic display scales. Refer to the 
NI ELVISmx Help for required hardware connections.

Digital Reader
This instrument reads digital data from the NI ELVIS II digital lines. You 
can read eight consecutive lines at a time: 0..7, 8..15, 16..23 either 
continuously or you can take a single reading.

Digital Writer
This instrument updates the NI ELVIS II digital lines with user-specified 
digital patterns. You can manually create a pattern or select predefined 
patterns, such as ramp, toggle, or walking 1s. This instrument can control 
eight consecutive lines and either continually output a pattern or just 
perform a single write. The output of the NI ELVISmx Digital Writer SFP 
stays latched until another pattern is output, the lines it is using are 
configured for read, or the power is cycled on the NI ELVIS II workstation. 
Output voltage levels of the NI ELVIS II digital lines are TTL compatible.
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Digital Multimeter (DMM)
This commonly used instrument can perform the following types of 
measurements:

• DC voltage

• AC voltage

• Current (DC and AC)

• Resistance

• Capacitance

• Inductance

• Diode test

• Audible continuity

For capacitance and inductance measurements you must make connections 
to the DMM/Impedance Analyzer on the prototyping board. For all other 
measurements make connections to the DMM banana jacks on the 
benchtop workstation.

Dynamic Signal Analyzer (DSA)
This instrument is especially useful in advanced electrical engineering and 
physics classes. This instrument uses the analog input of the device to make 
measurements, and can either continuously make measurements or make a 
single scan. You can also apply various window and filtering options to the 
signal.

Function Generator (FGEN)
This instrument provides you with choices for the type of output waveform 
(sine, square, or triangle), amplitude selection, and frequency settings. 
In addition, the instrument offers DC offset setting, frequency sweep 
capabilities, and amplitude and frequency modulation.

Impedance Analyzer
This instrument is a basic impedance analyzer that is capable of measuring 
the resistance and reactance for passive two-wire elements at a given 
frequency.
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Oscilloscope (Scope)
This instrument provides the functionality of the standard desktop 
oscilloscope found in typical undergraduate laboratories. The 
NI ELVISmx Oscilloscope SFP has two channels and provides scaling and 
position adjustment knobs along with a modifiable timebase. You can also 
choose trigger source and mode settings. The autoscale feature allows you 
to adjust the voltage display scale based on the peak-to-peak voltage of the 
AC signal for the best display of the signal. You can choose between digital 
or analog hardware triggering. You can connect to the 
NI ELVIS II Oscilloscope from the BNC connectors on the front panel of 
the benchtop workstation.

The computer-based scope display has the ability to use cursors for 
accurate screen measurements.

Two-Wire and Three-Wire Current-Voltage Analyzers
These instruments allow you to conduct diode and transistor parametric 
testing and view current-voltage curves. The two-wire instrument offers 
full flexibility in setting parameters such as voltage and current ranges, and 
can save data to a file. In addition, the three-wire instrument offers base 
current settings for measurements of NPN and PNP transistors. Refer to 
NI ELVISmx Help for connection details. Both instruments have cursors for 
more accurate onscreen measurements.

Variable Power Supplies
You can control the output of the positive or negative variable power 
supply with these SFP instruments. The negative power supply can output 
between –12 and 0 V, and the positive power supply can output between 
0 and +12 V.
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Using NI ELVIS II with LabVIEW
This section provides an overview of using NI ELVIS II with LabVIEW.

LabVIEW Express VIs
With NI ELVISmx, the NI ELVIS II instruments have an associated 
LabVIEW Express VI. Express VIs allow you to interactively configure the 
settings for each instrument. This enables you to develop LabVIEW 
applications without extensive programming expertise. To access the 
NI ELVISmx Express VIs, open a LabVIEW block diagram and select 
Measurement I/O»NI ELVISmx from the function palette.

Table 3-1 shows the available NI ELVISmx Express VIs. Refer to the 
NI ELVISmx Help for more information.

Table 3-1.  NI ELVISmx Express VIs

NI ELVISmx Express VI

—
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Using NI-DAQmx with NI ELVIS II
NI ELVIS II is supported by NI-DAQmx, and therefore you can program 
it using the NI-DAQmx API.

Furthermore, some general AI, AO, and timing functionality of the device 
is available through the NI ELVIS II workstation and you can program it 
using NI-DAQmx. Refer to NI ELVISmx Help and NI-DAQmx Help for 
more information.

Using NI ELVIS II in SignalExpress
To use an NI ELVIS II instrument within SignalExpress complete the 
following steps:

1. Launch SignalExpress.

1. Click the Add Step button.

2. If NI ELVISmx is installed, NI ELVISmx is in the list of steps. Expand 
NI ELVISmx.

3. Choose the instrument to add under Analog or Digital»Acquire or 
Generate Signals.

4. Select the NI ELVIS II device from Device control.

5. Set the various controls on the configuration panel appropriately for 
the measurement.

6. Run the SignalExpress project.

For more information about using NI ELVIS II with SignalExpress, refer to 
the NI SignalExpress Workbench Help, which you can find through the 
Help menu in SignalExpress.

For more information about SignalExpress, refer to the Getting Started 
with SignalExpress Guide.
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4
Calibration

Electronic components such as ADCs are characterized by nonlinearities 
and drift due to time and temperature. Compensating for these inherent 
sources of error requires device self-calibration. To improve the accuracy 
of the system, you should periodically self-calibrate the NI ELVIS II.

You can self calibrate the NI ELVIS II by right-clicking the device in MAX 
and choosing the self calibration option.

Note Disconnect all protoyping board signals or remove the prototyping board before 
running self calibration.
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